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Glossary 

 

Term Description 

CC Email 
Info mail about the transmission of data in SWAN. A CC email recipient only 

receives the information about the transmission, but not the data. 

CFM 
Client Side File Manager – tool which is used by SWAN for uploading and 

downloading data. 

ISO-Image File 
Computer file which contains a memory image of the content of a CD or DVD, 

structured in ISO 9660 format. 

OFTP 

The Odette File Transfer Protocol (OFTP) is a protocol for the direct electronic 

transfer of files between two communication partners.  

It can be set upon different transport layers: 

Version 1 - ISDN (B and D channel), X.25, … 

Version 2 - TCP/IP (Internet) 

SWANcloud 

Product, distributed by SSC-Services GmbH for the worldwide exchange of 

engineering data. The subscription solution allows a cost-efficient data exchange as 

Internet service, which is available regardless of its location and without 

investments into IT infrastructure. 

SWANenterprise 

Product, distributed by SSC-Services GmbH for the worldwide exchange of 

engineering data. The purchase software allows the optional connection of third-party 

systems and the connection of external data exchange partners. 

TAR 

TAR is short for "Tape ARchive", which is an archiving tool in the UNIX environment 

that decompresses files sequentially into a single file (archive) and reading it again. 

The file ending for tar-archived files is .tar. 

URL Internet address or web address 

ZIP 

Format for compressed files, which reduces storage for archiving on the one hand 

and serving as container file on the other hand, where several related files or entire 

directory trees can be assembled. The file ending for zip-archived files is .zip. 
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1 Welcome to SWAN 
SWAN is a professional data management system for the automated OFTP/OFTP2 data exchange 

between development partners. With SWAN, SSC Services GmbH offers a modular solution that 

covers any demands in a secure data exchange within the engineering environment. 

Among other things, SWAN allows the worldwide connection of your partners through a secure data 

exchange portal, without the partner’s need for an own data exchange system. The integration into 

your development environment can also be realized with SWAN. The connection of external 

applications or the activation of internal processes is considerably simplified and standardized 

through the integration of web services. 

You can operate SWAN with the variants SWANenterprise and SWANcloud. 

 

 SWANenterprise – purchase licence  

 

The purchase software allows the optional connection of third-party systems and the 

connection of external data exchange partners. 

 

 SWANcloud - service through the Internet 

 

The subscription solution allows a cost-efficient data exchange as Internet service, being 

available site-independent and without investment into the IT infrastructure. 

 

The following manual describes the elements of the user interface for both SWAN variants and 

informs you about the general aspects of operation.  

The differences between both variants will be indicated accordingly. 
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2 General information about this manual 
The SWAN user manual describes the elements of the user interface of the SWAN client and also 

provides you with information about fundamental aspects of its operation.  

The user manual contains descriptions of the elements on the following tabs: 

– Job 

– Outgoing 

– Incoming 

– Settings 

– Project 

 

The tabs Offline and Admin are visible only to users with corresponding roles and authorisations. A 

description can be found in the SWAN admin manual. 

 

This manual contains various types of information, which are marked accordingly. 

– Instructions are preceded by the character ▪ .  

Example:  

 Click OK. 

 

– The results of an action follow after the symbol ». 

Example: 

» The XXX menu appears. 

 

– Controls in the SWAN user interface are shown in italics.  

Example:  

Job tab. 

 

– Useful information can be found in the paragraphs marked with an . 

 

 
Information 

You can ……. 
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3 System requirements 
The use of SWAN only requires an Internet browser and a valid SWAN client certificate.  

The client certificate is issued by the SSC certification authority and will be sent to the new SWAN 

user via email. 

As the certificate is verified upon every SWAN login, you should store the certificate in a secure 

directory on your computer. 

You will receive the certificate key-password in a separate email. It has to be entered during the 

installation. 

Manuals for the installation of the SWAN client certificate are available in the support area of our 

homepage (http://www.ssc-services.de). 

 

The following browser versions are supported:  

– Internet Explorer, from version 7  

 

– Firefox, from version 4.0  

 

The following browser components have to be activated and installed to make sure the data transfer 

(upload) is working correctly: 

 

– Session cookies 

 

– JavaScript enabled  

– Java plug-in from version 7  

– Java plug-in enabled 

– Java temp folder available and sufficient storage space 

 

– Windows temp folder available and sufficient storage space 

 

– Internet Explorer: URL UTF-8 sending enabled (URL UTF-8 encoding activated) 

 

– Screen resolution at least 1024x768 pixel 

» The application of SWAN on smartphones, netbooks or tablets is not possible or only 

possible to a limited extend. 

 

http://www.ssc-services.de/
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4 Launch SWAN  
 Start the Internet browser (Internet Explorer or Mozilla Firefox). 

 Enter the SWAN address (URL) into the address line of the browser. 

» The SWAN login screen is displayed. 

 Log in with your user name (user ID) and your password. 

 

 

Figure 4.1 SWAN Login 
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5 Select the language of the program interface 

 Click on Language. 

» A list with the supported languages of the user interface is displayed. 

 

By now you can select the following languages: 

 German 

 English 

 French 

 Japanese 

 Russian 

 Turkish 

 Chinese 

 Portuguese 

 Spanish 

 Click on the desired language. 

» The desired language is applied to the program interface. 

 

 
Info 

You can also select the language from the Settings tab. 

 

 

Figure 5.1 Select the language of the program interface 
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6 Help and support for problems 

6.1 Online manual and online help 

 Click on Help to access the online manual. 

 Please use the buttons and  to access online help and additional information on the 

single steps of processing. Note the feedback of the system.  

6.2 Support area of the SSC homepage 

In the support area of our homepage http://www.ssc-services.de you find different documents and 

service tools, which can be used for trouble shooting on occurring difficulties. 

 Click on Info to access the support area of the SSC homepage. 

6.3 Service Desk 

Please contact our Service Desk if you need further support.  

Our expert team will provide advice from Monday until Friday between 7:00 AM and 05:00 PM. 

SSC-Services GmbH 

Herrenberger Str. 56 

71034 Böblingen 

Phone:  +49 (0) 70 31/4 91 31 00 

Mail: servicedesk@ssc-services.de 

Internet: http://www.ssc-services.de 

 

Figure 6.1 Help - SWAN online help 

 

Figure 6.2 Info – support area on the SSC homepage 

http://www.ssc-services.de/
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7 The link 'Welcome [signed-in user]'  
Information about your SWAN account is available under this link: 

 Change password 

 Personal data 

 Contact data of the Service Desk 

 Address codes for the receipt of jobs 

 System news 

 Usage agreements (option for SWANenterprise) 

 Permissions 

 

 

Figure 7.1 Welcome – SWAN account information 
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Figure 7.2 Information on your SWAN account 
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8 Settings tab 
Change and store different default settings under the tab Settings.  

 Activate the tab Settings. 

» The current SWAN settings are displayed. 

 Activate the corresponding menu to adjust your settings. 

 Settings 

 Job lists 

 Delegation 

 

Figure 8.1 Settings tab 



Settings tab 
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8.1 Settings menu  

The SWAN system administrator can adjust the visibility of options and define the corresponding 

values of the areas that can be adjusted by the users.  

 Activate the settings menu. 

 Select the desired options. 

 Click on Save to use the settings for forthcoming jobs. 

 

The following table describes the most used options. 

 

 

Figure 8.2 Settings > Settings 
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Option Description 

Timezone 
Timezone of the server location. 

Example: Location Germany  Europe/Berlin 

Startpage after login 
Select which tab shall be activated after the login: 

Job – Outgoing - Incoming – Project - Offline (only in SWANenterprise). 

Default recipient The default recipient is entered into the To: field for news jobs. 

Number of jobs per page Define how many jobs are dispalyed per page. 

Font size Font size of the user interface. 

Language Language of the user interface. 

Default additional text Enter the text that shall be sent to the data recipient in new jobs.  

Default Send path Select a directory, which is used as default when selecting files for sending. 

Additional text Switch on / off the use of a default additional text for a new send job. 

Standard project 
Enter a project identifier, which is transmitted to the data recipient in a new 

job. 

Project identifier Switch on / off the use of a project identifier in a new job. 

Default Target Directory Select a directory, which is used as default when storing received files. 

Extract ZIP/TAR file 

when receiving? 
Set up how to process received ZIP/TAR files. 

Receive directory as 

default 
Switch on / off the use of a default receive directory. 

Table 8.1 SWAN settings – most used options 



Settings tab 
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8.2 Job lists menu 

Here you define which columns shall be displayed in the job lists for sending (Outgoing tab) and 

receiving (Incoming tab) data. 

 Activate the menu Job lists. 

 Activate the corresponding check box and save your selection. 

  

 

Figure 8.3 Settings > Job lists 
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8.3 Delegation menu 

The delegation feature allows you to grant other users from your company access to your jobs. You 

can grant temporarily limited rights for reading, downloading and receiving a CC email for incoming 

jobs.  

 

 
Info 

Every 6 months SWAN sends an email to all users who have set up one or more delegates. This email contains 

all delegations of the corresponding user and a direct link to manage these delegations. 

 

 Activate the Delegation menu. 

 Click on Add user  . 

» The Edit access settings menu is displayed. 

 Click on . 

» The search mask with the search criteria is displayed.  

 Select a user with the search criteria. 

 Click on  to select the desired user from the search results. 

 Edit the access settings and save the selection. 

The access is temporarily unlimited if you don’t enter the field Valid until. 

 

 

Figure 8.4 Settings > Delegation 
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9 Job tab 
On the job tab you can create and send jobs. 

 Activate the Job tab. 

9.1 New EDI job area 

In this area you can select the data recipients, CC email recipients and the data to be sent and provide 

additional information to the data recipient. 

 

Figure 9.1 Job tab 

Field Description 

From: 
Selection as to whether you want to send data as a user or as 

a project member, in the name of a project. 

(This is only displayed if you are assigned to a project.) 

To: Recipient of the data 

CC email Recipients who shall be informed about the data transmission 

Project 
You can enter a project ID here, or if you send out data in the 

name of a project, the saved project name is entered here.  

Additional text Additional information for the data recipient 

Options SWANenterprise – processing options and offline job 

Data 

Data source  

 SWANcloud – only file system 

 SWANenterprise – file system and other sources 

Table 9.1 New job – description of the input fields 
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Project function info 

The project function enables you to send out data in the name of a project.  

The field From: is only displayed if you are assigned to a project.  

The Project tab is displayed only for persons who are responsible for a project and for project members. 

Via the link 'Welcome [registered user]', you can see whether you are a project manager in the Permissions area. 

Corresponding business roles are required for creating and managing projects, and these are assigned by the 

System Administrator. 

If the job has been fully worked through after transmission, it is displayed in the outgoing list of all project 

members. 

If files are sent to a project, the job appears for all project members in the incoming list. 

 

 
Info 

The fields project identifier and additional text are optional and can be enabled or disabled through the settings 

menu.  

The field Options is only available in SWANenterprise. 

9.1.1 Select recipient  

Data recipients receive the data and are informed via email (option) with PDF data delivery note 

(option) that the data is ready for download.  

 

 
Info 

Recipients within the own company or users within the portal solution (SWANcloud) receive an email. Recipients 

who receive the data via OS4X don’t get an email. 

 

CC email recipients don’t receive any data; they are only informed via email with a data delivery note 

about the transmission. 

There are several options for the recipient selection: 

 Quick selection (last 15 recipients) 

 Quick search 

 Selection via search mask 

Quick selection 

SWAN stores the last 15 recipients. You can select the desired recipient directly from the list Last 

5 recipients. 

 Click on the desired recipient. 

 The selected recipient is entered into the field To:. 

 Click on  for further information about the selected recipient. 
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Quick search 

 Enter the field To: and provide 

 First name,  

 Last name,  

 Company or  

 User name (User id) of the desired recipient. 

» A list of suggestions is displayed when entering the first three letters. 

 

 
Information 

Please use the selection via the search window to search for a project name. 

 Click on To: and use the search field Project. 

 

 Click on the desired recipient. 

» The selected recipient is entered into the field To:. 

 

Figure 9.2 Recipient selection – quick selection 

 

Figure 9.3 Recipient selection - Quick search 
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 Add other recipients, if desired. 

 Click on  to get information about the selected recipients. 

Selection through search mask 

– Select search directory 

Here you define the directory where you want to search for the recipient. 

 Click on To: 

» The search mask is displayed with different search criteria. 

 First select the desired option from the list Directory. 

 

– Execute search 

Make your entries in the different search fields. 

 Enter the corresponding search field and click on Search or confirm with [ENTER] 

» A list with the search result is displayed. 

– Select recipient  

 Click on the desired recipient in the list Search Result. You can select several recipients at the 

same time. 

» The selected recipient is highlighted. 

 Click on To>> or CC>> 

» The selected recipient is added to the corresponding recipient list. 

 

Figure 9.4 Recipient selection - search mask (1) 
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 Add other recipients, if required. 

 Remove all or selected recipients from the list by clicking on Remove All or Remove. 

– Recipient and personal address book 

You can add or remove recipients to and from your personal address book. 

 Search for the desired recipient via the recipient search. 

 Select the desired recipient. 

 Click on  to add a selected recipient to your personal address book or click on  to 

remove the recipient from your address book. 

 

 
Info 

Once having sent data to a recipient, it will be added to your personal address book automatically. 

 

– Query recipient details  

 Click on recipient details to get information on the selected recipient. 

– Finish recipient selection 

 Click on OK. 

 Now you can make further entries in your job. 

 

 

Figure 9.5 Recipient selection - query recipient details  
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9.1.2 Select data from the file system 

 Select the entry Filesystem under Data. 

» The window Add file is displayed. 

 
Info - Option for SWANenterprise 

Besides the opportunity to select your files from the file system in SWANcloud, the product SWANenterprise 

provides you with the opportunity to select data from e.g. a connected CAD or PLM system. In this case, there 

are more entries available under Data. 

 

Figure 9.6 Selecting the send directory 

 

Figure 9.7 Selecting data from the filesystem 
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 Select: 

 A single file through double click.  

» The file is directly added to the send list.  

 A single file through mouse click and click on Add file. 

» The file is added to the Log window. 

 Several files with CTRL/SHIFT key and click on Add file. 

 Add further files, if desired. 

 Click on Tar or Zip, if you wish to compress the file size. 

 
Info 

With the option create container, you can compress the selected files into a Tar or Zip container. You can enter 

a name for the Tar or Zip archive. If you don’t enter a name, the system will generate one.  

You can select entire directories by activating recursive? 

The whole structure will be added, i.e. the generated TAR file might be very large for deep directory trees.  

 Check the size before selecting. 

 Consult with the recipient, if he’s able to handle directory structures, as many companies cannot process 

directories due to automatic receipt processes. 

 

 Click on Back to job overview to add the files to the job list. 

» Through the Recycle bin icon at the bottom of the line you can remove single files from 

the job list. 

9.1.3 Sending options (option in SWANenterprise) 

Depending on the supported processes of your SWANenterprise variant you can select different 

processing options. 

 Click on Options in the area New EDI job. 

» The window Sending options is displayed. 
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 Activate the tab Processes. 

 

 Select the desired process step. 

 

Figure 9.8 Sending options in SWANenterprise 

 

Figure 9.9 Process steps in SWANenterprise 
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 Click on OK. 

 

 
Info - Option in SWANenterprise 

In addition to SWANcloud, the product SWANenterprise provides extended compression methods, allowing you 

to process your files before sending. You can define the desired process steps under Options. The processing is 

made in the order of the process step selection. 

A conversion (e.g. CATIA  JT) always has to be made prior to a compression (TAR, ZIP,GZIP).  

 Consider the order when selecting the process steps.  

 ▪ Please note that only one conversion step and one compression step can be used for each job. 

 

9.1.4 Send job  

When you have added all files to the job and selected the desired processing options (option for 

SWANenterprise) you can complete the job creation. 

 Click on Send Job. 

» The job is processed and the files are sent. 

» The summary view of the outgoing tab is displayed, showing you the details on the job. 

» The green checkmark  is displayed when the corresponding section is completed 

successfully. 

 

 

Figure 9.10 Job details – Overview Screen 
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The job has been transferred successfully when all three sections are checkmarked. 

 

Outgoing tab 

Left checkmark: The files have been transferred from the client (user PC) to the server. 

Centre checkmark: The job has been processed. 

Right checkmark: The job has been passed to the sending system for transmitting to the 

recipient. 

 

Incoming tab 

Left checkmark: The job has been received. 

Centre checkmark: The job has been processed. 

Right checkmark: The job has been delivered to the local recipient. 

  

 

 
Info - Client Side File Manager (CFM) 

The upload and download of data is executed by Client Side File Manager (CFM). 

 Please find information about the use of CFM in the attachment of this document. 

 

 Click on Logfile or Job files in order to receive further information about your job. 

 

  

 

Figure 9.11 Job transferred successfully 
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Figure 9.12 Job details – Logfile Screen 

 

Figure 9.13 Job details – View of the job files 
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9.1.5 Offline data exchange (option in SWANenterprise) 

SWANenterprise allows you to exchange data via encrypted data carrier (CD/DVD). This could be 

necessary if the recipient has no own OFTP system or if the data amount is too extensive for a 

transmission via Odette/ISDN.  

A so called offline administrator can create media and is able to read-in received media to forward 

these to a recipient in SWAN.  

Create offline job 

The recipient selection and the selection of files is made like for a regular job.  

 Select the data recipient and the files for sending. 

 Click on Options. 

» The window Sending options is displayed. 

 Activate the Offline tab. 

 Select the desired media and the offline administrator. 

 Click on OK. 

 Click on Send job. 

» An ISO image file is created and will be transmitted to the offline administrator.  

» The offline administrator creates the media with encrypted data and the creator of the 

offline job receives an email with a password, the recipient of the media receives a so 

called Private Key. These two components provide the key for reading the data. 

 

Figure 9.14 Datei-Optionen - Offline 
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Decrypt the content at the recipient  

By means of a client, which is written on every medium along with the engineering data, the recipient 

can decrypt the data in a user-friendly interface and unpack them automatically, if desired. For this 

purpose, the corresponding password has to be transmitted by the job creator. Afterwards the data 

is available for further processing. 

Read-in medium  

The offline administrator can read-in the data from a data carrier into SWAN and send the data to a 

recipient. In this course a fully equipped Odette job is created and can be researched in SWAN. 
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9.1.6 Cancel job  

With the Cancel job button under Actions you can cancel the transmission of a job. 

 
Info  

Depending on its size, it might not be possible to cancel a job anymore.  

You cannot restart a cancelled job by yourself. 

 Please create a new job if you wish to send the job after you have cancelled it. 

 

  

 

Figure 9.15 Cancel job  
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9.2 Actions Group 

9.2.1 Reset job  

You can delete the entries from the group New EDI job and reset them to the default settings (Settings 

tab). 

 Click on Reset job under the group Actions. 

» The entries in the input fields will be deleted and reset to the default settings. 

9.2.2 Templates 

You can create templates and select these for recurring send jobs. 

Create new template 

 Activate the Job tab. 

 Fill in the fields under New EDI job. 

 Click on Templates under Actions. 

 Activate Save template. 

 Select a name for the template and confirm with OK. 

 

Figure 9.16 Create template 
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Manage and use template 

 Activate the job tab. 

 Click on Templates under Actions. 

 Activate Manage and use template. 

Here you can  

 Search for templates, 

 Delete templates 

 Select templates for a new send job. 

 

Figure 9.17 Manage and use template 
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9.2.3 Default recipient 

If you have defined a default recipient, it is automatically entered for a new job in the field To:. 

 

 
Info 

You can set up the desired default recipient under Settings.  

 

 Click on Default recipient under the group Actions. 

» The window for managing default recipients is displayed. 

 

You can  

 Search for recipients, 

 Select a recipient as default recipient, 

 Delete an existing default recipient. 

 

Figure 9.18 Edit default recipient  
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9.2.4 CC email addresses 

CC email recipients don‘t receive any data; they are only informed about the data transfer via email 

with a data delivery note.  

 Click on CC email addresses under the group Actions. 

» The window for managing the CC email addresses is displayed. 

You can 

 Setup and delete CC email addresses, 

 Search for stored CC email addresses, 

 Add a CC email address as recipient to the send job. 

 

 

Figure 9.19 CC email addresses –selection box 

 

Figure 9.20 CC email addresses – new entry 
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10 Outgoing and incoming tab 
On the Outgoing and Incoming tabs you can manage your send and receive jobs, i.e. you can  

 Query information about jobs, 

 Download sent and received files , 

 Send and receive files again or forward them  

 Search for jobs (search template). 

 

 Activate the Outgoing tab. 

» The outgoing list is displayed as overview of all sent jobs. 

or 

 Activate the Incoming tab. 

» The incoming list is displayed as overview of all received jobs. 

 

 

Figure 10.1 Example - Outgoing list 
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10.1 Query information about jobs 

10.1.1 Select job via status icon 

On the views 

 Overview 

 Logfile 

 Job files 

You find information about a job that you have selected before. 

 Double click on the status icon of the desired job. 

» The Overview is displayed. 

» Activate the Logfile or Job files view to display further information. 

» The selected job is highlighted pink in the outgoing and incoming list. 

 

 
Info 

The information from the views Overview, Logfile and Job files cannot be queried until the job has been selected. 

The selection is made through double click on the Status icon or by clicking on Job details under job information. 

» The Overview is displayed. 

» The selected job is highlighted pink in the outgoing and incoming list. 

The checkbox in the first column of the job lists is only used to select the jobs for downloading. 

» Jobs for download are highlighted (coloured) and the checkmark is set. 

Information is only displayed for the pink highlighted job. 
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Figure 10.2 View - Overview 

 

Figure 10.3 View - Logfile 
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Figure 10.4 View - Job files 
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10.1.2 Select Job through info icon  

You can query different information about your job through the info icon  in the last column of the 

job lists.  

 

 
Info 

The information from the views Overview, Logfile and Job files cannot be queried until the job has been selected. 

The selection is made through double click on the Status icon or by clicking on Job details under job information. 

» The Overview is displayed. 

» The selected job is highlighted pink in the outgoing and incoming list. 

The checkbox in the first column of the job lists is only used to select the jobs for downloading. 

» Jobs for download are highlighted (yellow) and the checkmark is set. 

Information is only displayed for the pink highlighted job. 

 

 Click on  in the incoming list. 

» The view Job information is displayed. 

» Navigate to the next or previous job with the arrow buttons  . 

 Click on Job details for detailed information. 

» The Overview is displayed. 

» Activate the views Logfile or Job files to display further information. 

» The selected job is highlighted pink in the outgoing and incoming list. 
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Figure 10.5 Example - Job information 
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10.2 Identify job status  

The small coloured square in front of every job displays the current status. A mouse-over on the icon 

shows information about the meaning of the icon. The following table shows a selection of the most 

used icons.  

10.2.1 Job status of the outgoing list 

 

Job status Description 

  finished Job has been transferred to the recipient successfully. 

  waiting / processing Job is being processed / sent. 

  created Job has been created, the data is uploaded by CFM 

  downloaded 

Job has been downloaded by the sender.  

You can download a job several times during the agreed provision 

period. 

  stopped Job has been stopped. 

  failed 
Job has run on error during processing.  

Please contact the Service Desk. 

  deleted Job has been deleted 

Table 10.1 Job status – icons outgoing list 
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10.2.2 Jobs status of the incoming list 

10.3 Using search mask  

In the list of send and receive jobs you can search for general criteria in the Simple view and for 

special criteria in the Extended view. Here you can also create a search template.  
 

 
Info 

A search template which is already active is tagged with the icon (  instead of ). The name of the active 

search template can be seen through mouse-over. 

 

 Select the desired view. 

 Enter the search criteria. 

 Click on Search/Refresh. 

» A list with the search results is displayed. 

10.3.1 Search mask - Simple view 

In the Simple view search mask you can search for the following general criteria: 

– Job number 

– Project identifier 

– Additional text 

Job status Description 

  ready for download 

Job is ready for download from the incoming list during the 

agreed provision period. 

  processing Job is being processed 

  downloaded 

Job has been downloaded by the recipient.  

You can download a job several times during the agreed provision 

period. 

  stopped Job has been stopped. 

  failed 

Job has run on error during processing.  

Please contact the Service Desk. 

  deleted Job has been deleted 

Table 10.2 Job status – icons incoming list 
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– Period 

– Sender  

(First name, last name, user name, project name, department, location and company of the 

sender) 

– Recipient  

(First name, last name, user name, project name, department, location and company of the 

sender) 

– Files (file name) 

 

 Click on Simple view. 

 Enter the search criteria. 

 Click on Search/ Refresh. 

» A list with the search results is displayed. 

 
Info – search mask input 

You get an overview of the input possibilities by mouse-over on the search field description. 

10.3.2 Search mask - Extended view 

In the extended view of the search mask you can search for the following additional criteria: 

 Status  

 Job type 

 Archiving status 

 

 Click on Extended view  

 Enter the search criteria. 

 Click on Search/Refresh. 

» A list with the search results is displayed. 

 

Figure 10.6 Search mask - Simple view 

 

Figure 10.7 Search mask - Extended view 
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10.3.3 Create search template 

You can save search criteria in a search template for recurring search processes. 

 Enter the desired search criteria into the search mask of the simple or extended view and 

click on Search/Refresh to start the search. 

 Click on  to save the search criteria. 

» The selection box Search templates is displayed. 

» Stored search templates are displayed. 

 Choose an appropriate name for the search template and click on Save. 

 

 
Info 

You have to perform a search with the corresponding search criteria before you’re able to store the search 

template. 

 

 

Figure 10.8 Save search template (1) 

 

Figure 10.9 save search template (2) 
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10.3.4 Activate search template 

You can use stored search templates for searching. A search template that is already active is 

indicated by the change icon (  instead of ). 

 Click on  or  to select a stored search template. 

» The selection box Search templates is displayed. 

» Search templates that are already stored are displayed. 

 Click on the search template you wish to select. 

 Click on  to show information on the search template. 

 Click on OK to start the search process. 

10.3.5 Reset search template 

You can clear the applied search criteria and disable the active search template. 

 Click on Reset. 

» The search criteria will be deleted. 

» The active search template will be disabled. 

» The icon of the search template is changed to .. 

10.4 Export job lists 

You can export the job lists as Excel file. 

 Click on Excel Export. 

» The selection list for the export is displayed. 

 Activate the information required for the export. 

 

 

Figure 10.10 Export job lists - Excel Export 
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Figure 10.11 Export job lists – select the information 
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10.5 Download files 

10.5.1 Select incoming job  

Data recipients are informed about incoming data via email with a data delivery note and can access 

the received data through the Incoming tab. 

 Activate the Incoming tab. 

 Use the search mask to filter extensive incoming lists for certain criteria.  

 

Download single jobs 

 Click on  in the last column to download a single job. 

» A list of files belonging to the job is displayed. 

 Select the desired files. 

 

Figure 10.12 Download files - Incoming list  

 

Figure 10.13  Download files - selection 
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Download several jobs 

 Select the desired jobs. 

 Highlight the jobs in the first column of the job list or click into the lines of the desired jobs. 

» The selected jobs are highlighted. 

 Click on Download. 

» A list of the files belonging to the job is displayed. 

 Select the desired files. 

10.5.2 Select target directory  

You can enter a default target directory where the files are stored under the Settings tab or you can 

select the directory in the field Change target directory. 

 

 
Info - option in SWANenterprise 

Besides the opportunity to download your files to the file system in SWANcloud, the product SWANenterprise 

provides you with the opportunity to download data to e.g. a connected CAD or PLM system. In this case, there 

are more entries available under Change target directory. 

 

 Select the option Filesystem under Change target directory.  

» The selection box Apply is displayed. 

 Select the target directory and click on Apply. 

 Click on Download files. 

» The files are downloaded into the desired target directory. 

 

 
Info 

If you click on Download files without changing the target, the files will be downloaded to the directory that has 

been defined as default under Settings. 

 

 
Info - Client Side File Manager (CFM) 

The upload and download of data in SWAN is executed by Client Side File Manager (CFM). 

 Please find information about the use of CFM in the attachment of this document. 
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Depending on the selected default setup under Settings (dialogue, never, always), a dialogue box is 

displayed when you download a ZIP or TAR file, asking if the container (ZIP or TAR) shall be unpacked.  

 

 

Figure 10.14  Download files - select target directory  

 

Figure 10.15  Dialogue on ZIP or TAR file 
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11 Project tab 
 

 
Project function info 

The project function enables you to send out data in the name of a project.  

The field From: is only displayed if you are assigned to a project.  

The Project tab is displayed only for persons who are responsible for a project and for project members. 

Via the link 'Welcome [registered user]', you can see whether you are a project manager in the Permissions area. 

Corresponding business roles are required for creating and managing projects, and these are assigned by the 

System Administrator. 

If the job has been fully worked through after transmission, it is displayed in the outgoing list of all project 

members. 

If files are sent to a project, the job appears for all project members in the incoming list. 

 

 
Information 

On the Settings tab, you can set up the presets for the default project and for displaying the project ID when 

sending out jobs.  

 Enter the required presets here. 

 

When creating a new job, all users assigned to a project can enter as the sender a project sender 

and a project ID. 

If the job has been fully worked through after transmission, it is displayed in the outgoing list of all 

project members. 

If files are sent to a project, the job appears for all project members in the incoming list. 

Projects are logically linked to servers.  

A user requires the business role project definition to create and manage projects. The system 

administrator assigns this role in the user admin area. 

Depending on your role in the project, you can do the following for projects in which you are a member 

(My Projects): Search for projects, edit projects, create new projects and assign users as project 

members to a project. 

 

Figure 11.1 Job tab – Project sender 
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There are the following roles within a project: 

 The system administrator has unrestricted administration rights for all projects. He/she 

assigns the business role project definition to the person responsible for the project. 

 The person who is responsible for the project has unrestricted administration rights for 

his/her project (mandatory, 1 person). The person who is responsible for the project cannot 

be deleted from the project. 

 The project deputy can accept members into the project or remove members from it 

(optional, multiple persons possible). 

 A project member has no administration rights (optional, multiple persons possible). 

 

11.1 Search project – Edit project 

 
Information 

If you do not enter any search criteria for your search, you will receive all existing entries as a result.  

 

You can use the following as search criteria: 

– Project name A project has a name and its own address code. 

– Member 

name/member 

first name 

A project is assigned to at least one user (the person 

responsible for the project). 

 Activate the Project tab. 

 Enter your search criteria and start the search by clicking on Search or click on My Projects. 

» The search results appear. 
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 Select the required entry. 

 

 In the Actions column, click on  next to the required entry. 

» The data appears on the Project Data tab. 

» You can add or delete project members and change the role in the project.  

» A project logbook appears in an area on the right-hand side.  

Here, you can receive information about the project management. 

» In the Actions area on the left-hand side, you can select from the actions available at this 

level. 

 Edit the entries and click on Save. 

 

Figure 11.2 Project tab – Search result – My Projects 

 

Figure 11.3 Project tab – Search project 
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11.2 Creating a project 

A user requires the business role project definition in order to create and manage projects. 

This business role is assigned by the System Administration.  

When creating a new project, you need to enter a project name and a cost centre. The name of the 

project can be freely chosen. Since a project name is visible to all SWAN users, you must make sure 

that the project name is not subject to a requirement for secrecy.  

In addition, you must assign a responsible person to the project from the SWAN partner data and 

allocate the role of responsible person to him/her. 

▪ Activate the Project tab. 

▪ In the Actions area, click on Create Project. 

» An empty input window pops up on the Project Data tab. 

▪ Edit the entries and click on Save. 

▪ Add a user and assign the role of responsible person to him/her. 

▪ Click on Add Project Member to select further project members and assign the role of 

Deputy or Member to them. 

▪ Click on Save. 

 

Figure  11.4 Project tab – Project data 
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Figure  11.5 Project tab – Add project member 
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12 Logout 
You shouldn’t just close the browser window when your work with SWAN is finished. 

 Click on Logout to end your SWAN session. 

 

 

Figure 12.1 Logout 
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Annex: CFM - Client Side File Manager 

1 Introduction 
The upload and download of files in SWAN is executed by CFM - Client Side File Manager.  

Upon the initial start (sending or receiving the first job in SWAN), CFM will set up required files in a 

temporary directory on your computer. 

Under WindowsXP:  

C:\Documents and Settings\[USER-ID]\Local Settings\Temp\[USER-ID]\cfm 

Under Windows7:  

C:\Users\[USER-ID]\AppData\Local\Temp\[USER-ID]\cfm 

 

 
Info - Client Side File Manager (CFM) 

The configuration of CFM could take several minutes for the first job. 

 

2 CFM main view 

2.1 File 

On the File tab you can Minimize CFM To Task Bar or Exit. 

 

Figure A 1 CFM - files 

 

Figure A 2 CFM – main view File 
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2.2 Settings 

On the Settings tab in der main view of CFM you can make different settings on the configuration of 

the client and the proxy server. 

 
Info - Client Side File Manager (CFM) 

If your company uses an automatic proxy configuration script, please contact your local administrator. The port 

443 must be opened. 

2.3 Help 

The CFM manual can be opened under the Help tab. 

3 Uploading files with CFM 

As soon as you complete the job creation with Send job, CFM is started in the background.  

 Click on Send job. 

» The SWAN-Icon  is displayed in the task bar and CFM starts to upload the 

job onto the server. 

  

 

Figure A 3 CFM – Settings tab 
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4 Track upload/download process 

4.1 Job overview 

CFM allows you to track the status of the upload and download process. 

 Double-click on the SWAN-Icon in the task bar.  

» A window with information on the job is displayed. 

 Click on Main Overview, to access an overview of all transfer jobs. 

 

 
Info - Client Side File Manager (CFM) 

You can show or hide files that belong to the job in order to get specific information, e.g. transfer progress. 

 

 

Figure A 4 CFM - Example: upload information on job 

 

Figure A 5 CFM – main overview of transfer jobs 
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4.2 Query details on transfer job  

You can query details on a specific transfer job and request support through the Service Desk in case 

of errors. 

 Select a transfer job. 

 Click on Details for further information.  

» A window with the transfer information of the job is displayed. 

If you have any problems with the transfer (e.g. an unexpected connection breakup) you can request 

support through our Service Desk under the detail view. 

 Click on Details of the transfer job where an Error status is displayed. 

» A window with the transfer information of the job is displayed. 

 Click on Request Support. 

» An automatic support request will be sent to the Service Desk. 

Name Description 

Transfer Overview of selected files  

Status 
Status of the transfer job 

(download, error, cancelled, processing, complete) 

Size Size of the file 

Created  Date and time  

Transfer progress Status display on the transfer progress 

Figure A 6 CFM – main overview information 

 

Figure A 7 CFM – transfer information 
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4.3 Clear list of transfer jobs  

 Select a transfer job. 

 Click on Delete.  

4.4 Cancel transfer job  

If you have accidentally selected the wrong job for download you can cancel the transfer. 

 Select a transfer job. 

 Click on Cancel.  

» The status of the job is changed to Error. 

4.5 Resume transfer job  

If the transfer is interrupted (e.g. manually cancelled or connection breakup due to network problems) 

you can resume the transfer. 

 Select a transfer job. 

 Click on Resume.  

» The transfer of the job is resumed. 

5 Download data with CFM 
Likewise to uploading data to the SWAN server, CFM executes the download of data. 

The files are transferred decrypted. CFM decodes this data in the background by means of a key and 

provides the decrypted data to the specified target directory. 

CFM checks if the job contains ZIP or TAR archives and supports you with the unpacking process. 

 

Figure A 8 CFM – download information on Job 
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As soon as the files have been processed by CFM, the status is changed to Complete. The files are 

stored in the specified target directory. 

 Click on Open directory to get to the specified folder. 

 

 

Figure A 9 CFM – unpack archives 
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